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Sinowealth BMS Tool Introduction 

 

1. Introduction 

➢ PC upper computer software operating environment 

For Windows 7 and above, you need to run the host computer software as an administrator (Windows XP and Windows 2000 are not supported). 

➢ Communication interface 

Standard USB to UART interface. 

Note: The corresponding host computer version of the host computer introduction document V0.1 is Sinowealth BMS Tool V0.1.exe . 

 

2. Basic Functions 

 

2.1. Select IC model and configure serial port 

 

Execute the host computer software *.exe as an administrator to enter the serial port & IC configuration interface: IC model can be selected 

SH367303/367305/367306/367309/39F003/39F004/39F005 (This document mainly uses SH39F003 as an example for introduction). 

Select the serial port number "COM n" → set the baud rate to "9600" → set the data bit to "8" → set the check digit to "None" → set the stop bit to 

"1", after the configuration is completed, 

Select "open port", it will prompt "open port COM n successfully", then click "OK" to enter the main interface. 

The main interface includes menu bar, scan information, MCU Parameters, calibration, backup. 
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2.2. Menu bar 

The menu bar includes: files, options, and help.  

 

 
➢ File 

The "File" menu includes: 

Open DataFlash file (text format): load MCU parameter area data 

Save DataFlash file: save data in MCU parameter area 

Start/stop recording data: you can record and save the contents checked in the "Information" interface 

➢ Options 

The "Options" menu includes: language setting, scanning, setting Log time interval, serial port configuration, software upgrade; 

Language: Simplified Chinese, English. 

Scan: On/Off (the default is on, when "Off" is selected, the scan interface will not update data). 

Set Log time interval: Set the data logging interval time (unit is 1S). 

Serial port configuration: Configure COM port information: serial port number, baud rate, data bit, parity bit, stop bit. 

Software upgrade: The Code area and E2PROM area can be updated online individually or simultaneously.  
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➢ Help 

The "Help" menu includes: About (introduction to the version of the tool). 

2.3. Information interface 

Click "Information" to enter the information scanning interface, as shown below. 

 

➢ Zone "1" 

The voltage is normal: if there is no voltage protection, it will display green, otherwise it will display red, corresponding to the 

Status bit: OV, UV, AFE_OV; 

The current is normal: if there is no current protection, it will display green, otherwise it will display red, corresponding to the 

Status bit: OCC, OCD, AFE_SC; 

Normal temperature: if there is no temperature protection, it will display green, otherwise it will display red, corresponding to 

Status bits: OTC, OTD, UTC, UTD; 

Normal startup: if there is no disconnection protection, it will be displayed in green, otherwise it will be displayed in gray, 

corresponding to the Status bit: CTO; 

The port is normal: if the serial port connection is normal, it will display green, otherwise it will display red.  

 

➢ Zone "2" 

Clear Logs: Click this button to cancel all items in the Log zone "3"; 

Log All: Click this button to check all items in the Log zone "3"; 

Clear Scans: Click this button to cancel all items in the Scan zone "3"; 

Scan all: Click this button to check all items in the Scan zone "3"; 



Sinowealth BMS Tool Introduction Version 0.1 

 Translated with Google translate + some investments from Frederic Guiot
  

        Page 4 

➢ Zone "3" 
 
All parameters of information scan are updated every 1S. 

 

  
 

 

  

Name Type of data Length Byte Function description 

Cell1 Voltage unsigned int 2 Returns the voltage value of cell 1 (mV) 

Cell2 Voltage unsigned int 2 Returns the voltage value of cell 2 (mV) 

Cell3 Voltage unsigned int 2 Returns the voltage value of cell 3 (mV) 

Cell4 Voltage unsigned int 2 Returns the voltage value of cell 4 (mV) 

Cell5 Voltage unsigned int 2 Returns the voltage value of cell 5 (mV) 

Cell6 Voltage unsigned int 2 Returns the voltage value of cell 6 (mV) 

Cell7 Voltage unsigned int 2 Returns the voltage value of cell 7 (mV) 

Cell8 Voltage unsigned int 2 Returns the voltage value of cell 8 (mV) 

Cell9 Voltage unsigned int 2 Returns the voltage value of cell 9 (mV) 

Cell 0 Voltage unsigned int 2 Returns the voltage value of cell 10 (mV) 

Total Voltage unsigned long 4 Returns the total voltage value of the battery (mV) 

External Tempe1 unsigned int 2 Return battery temperature 1(℃) 

External Tempe2 unsigned int 2 Return battery temperature 2(℃) 

IC Tempe1 unsigned int 2 Chip internal temperature 1 

IC Tempe2 unsigned int 2 Chip internal temperature 2 

CADC Current signed long 4 Return real-time current value (mA) 

FullChargeCapacity unsigned long 4 System full charge capacity (mAh) 

RemainingCapacity unsigned long 4 Return the current remaining power of the battery pack (mAh) 

RSOC unsigned int 2 Returns the percentage of remaining power of the battery pack (%) 

Cycle Count unsigned int 2 Cycle discharge times 

Pack Status unsigned int 2 Return system status 

Battery Status unsigned int 2 Return to Battery status 

Pack Config unsigned int 2 MCU system configuration parameters 

ManufactureAccess unsigned int 2 Manufacturing information 
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➢ Zone "4" 

 The status bit of Pack and Battery, if the status bit is 0, it will be displayed in green , if it is 1 it will display red  
  
 

 

  

Bit symbol Description 

FST_DSG 1: Discharge MOS is always high 

MID_DSG 1: Discharge MOS is PWM output, high level duty is high 

SLOW_DSG 1: Discharge MOS is PWM output, high level duty is low 

DSGING 0: non-discharged state 

1: Discharge state 

CHGING 0: Not charging 

1: Charging status 

DSGMOS 0: Discharge MOSFET is off 

1: Discharge MOSFET is turned on 

CHGMOS 0: Charging MOSFET is off 

1: Charging MOSFET is turned on 

CAL 0: not calibrated 

1: Calibrated 

VDQ 0: The full charge capacity update is invalid 

1: Full charge capacity update is valid 

FD 0: no discharge cut-off 

1: Discharge cut-off 

FC 0: no charge cut off 

1: Charging cut off 

OCD 0: Discharge overcurrent protection has not occurred 

1: Discharge overcurrent protection occurs  

OCC 0: Charge overcurrent protection has not occurred  

1: Charge overcurrent protection occurs 

UV 0: Undervoltage protection has not occurred 

1: Undervoltage protection occurs 

OV 0: Overvoltage protection has not occurred 

1: Overvoltage protection occurs 

CTO 0: No disconnection protection 

1: Disconnection protection occurs 

AFE_SC 0: No hardware short circuit protection has occurred 

1: Hardware short circuit protection occurs 

AFE_OV 0: No hardware overvoltage protection has occurred 

1: Hardware overvoltage protection occurs 

UTD 0: No discharge low temperature protection 

1: Discharge low temperature protection 

UTC 0: Charging low temperature protection has not occurred 

1: Charge low temperature protection occurs 

OTD 0: No discharge high temperature protection 

1: Discharge high temperature protection 

OTC 0: No charging high temperature protection 

1: Charge high temperature protection occurs 
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2.4. MCU interface 

The MCU interface is mainly divided into four parts: system settings, charge settings, discharging settings, and calibration settings. 

➢ System settings 
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Settings Description: 

  
 

 

  

Name type of data Length Byte Function description 

AFEProtectConfig unsigned char 1 Front-end protection settings 

AFEOVvol unsigned int 2 Front-end overvoltage protection voltage 

PackConfigMap unsigned int 2 For battery pack configuration parameters, refer to the 

PackConfigMap description in the following table 

VOC[10] unsigned int 2*10 The voltage value corresponding to the battery pack capacity 

DesignCapacity unsigned long 4 System design capacity (mAH) 

FCC unsigned long 4 System full charge capacity (mAH) 

CycleThreshold unsigned long 4 Total discharge of the system in a single cycle (mAH) 

CycleCount unsigned long 4 Cycle discharge times 

LearnLowTemp unsigned int 2 Minimum temperature allowed for full charge capacity update 

NearFCC unsigned int 2 Difference between remaining capacity and full charge capacity at the 

beginning of effective discharge (mAH) 

DfilterCur signed int 2 Zero current detection window, current smaller than this window is 

displayed as 0 

PowerDownDelay unsigned char 1 Waiting time for entering low power mode (S) 

ChargeBackupDelay unsigned char 1 Effective charging time (Min) 

ChargeBackupCur signed int 2 The minimum current for judging effective charging in the data 

backup function (mA) 

RTCBackupDelay unsigned char  RTC data backup delay (S) 

SWVersion unsigned int 2 Software version: V2.00 

HWVersion unsigned int 2 Hardware version: V4.00 

ID unsigned char 1 Device ID "0xAA" 

MNFName[12] unsigned char 12 Manufacturer's name [12] 

MNFDate unsigned long 4 Manufacturing date 2018-03-28 

SerialNum unsigned int 2 Serial number 

DeviceName[12] unsigned char 12 Equipment name 

DeviceChem[12] unsigned char 12 Cell material 

ChemID unsigned int 2 Cell Chemistry ID 
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PackConfigMap description: 

Bit symbol Description Value 

DSGEnd Discharge cut off 0: Charging cutoff does not turn off the discharge MOSFET 

1: Charge cutoff, turn off the discharge MOSFET 

CHGEnd Charge cutoff 0: Charging cutoff does not turn off the charging MOSFET 

1: Charge cutoff, turn off the charging MOSFET 

TempNum Temperature monitoring point 0: Support 1 temperature point detection 

1: Support 2 temperature point detection 

LEDNum Number of indicator lights 0: No LED display 

1: Support 3 LED displays 

2: Support 4 LED display 

3: Support 5 LED displays 

CellNum[3] String configuration Number of battery strings configuration: 

000: 3 strings 

001: 4 strings 

010: 5 strings 

011: 6 strings 

100: 7 strings 

101: 8 strings 

110: 9 strings 

111: 10 strings 

EEPRomBK Data backup 0: Disable the data backup function 

1: Enable data backup function 

OCPM Electric MOS 0: Discharge overcurrent closes the discharge MOS, charge 

overcurrent closes the charge MOS 

1: Overcurrent turns off charge and discharge MOS at the same 

time 

CTO_EN Disconnection enable 0: Disable the disconnection detection function 

1: Enable disconnection detection function 

PF_EN Secondary protection enable 0: Disable secondary protection 

1: Enable secondary protection (PF pin output low level can be 

used to burn FUSE) 

BAL_EN Balance enable 0: Disable the balance function 

1: Enable balance function 

OCRC_EN OCC self-recovery 0: Disable over-current self-recovery enable 

1: Enable over-current self-recovery enable 

OV_EN Hardware overvoltage enable 0: Disable hardware overvoltage protection 

1: Enable hardware overvoltage protection 

SC_EN Hardware short-circuit enable 0: Disable hardware short circuit protection 

1: Enable hardware short circuit protection 
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➢ Charge settings 
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 Settings Description: 

 

  

Name Type of data Length 

Byte 

Function description 

OVvol unsigned int 2 Overvoltage protection threshold (mV) 

OVRvol unsigned int 2 Overvoltage protection recovery threshold (mV) 

DelayOV unsigned char 1 Overvoltage protection delay (S) 

DelayOVR unsigned char 1 Overvoltage protection recovery delay (S) 

ChgEndvol unsigned int 2 Charging cut-off voltage (mV) 

ChgEndCur signed int 2 Charging cut-off current (mA) 

DelayChgEnd unsigned char 1 Charge cut-off delay (Sec) 

OCCvol signed int 2 Charging overcurrent protection current (mA) 

DelayOCC unsigned char 1 Charge overcurrent protection delay (S) 

DelayOCCR unsigned char 1 Charge overcurrent self-recovery delay (S) 

BalanceVol unsigned int 2 Balance opening voltage (mV) 

BalanceVolDiff unsigned int 2 Balance opening pressure difference (mV) 

BalCurrent signed int 2 Balance open charging current (mA) 

BalanceDelay unsigned char 1 Balance opening delay (S) 

TempOTC unsigned int 2 Charging high temperature protection threshold (℃) 

TempOTCR unsigned int 2 Charging high temperature protection recovery threshold (℃) 

TempUTC unsigned int 2 Charging low temperature protection threshold (℃) 

TempUTCR unsigned int 2 Charging low temperature protection recovery threshold (℃) 

DelayTemp unsigned char 1 Temperature protection delay (S) 

DelayTempR unsigned char 1 Temperature protection recovery delay (S) 
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➢ Discharge settings 
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Settings Description: 

 

Name Type of data Length Byte Function description 

UVvol unsigned int 2 Overcharge protection threshold (mV) 

UVRvol unsigned int 2 Overcharge protection recovery threshold (mV) 

DelayUV unsigned char 1 Overcharge protection delay (S) 

DelayUVR unsigned char 1 Overcharge protection recovery delay (S) 

DsgEndvol unsigned int 2 Discharge cut-off voltage (mV) 

DelayDsgEnd unsigned char 1 Discharge cut-off delay (Sec) 

OCDvol signed long 4 Discharge overcurrent 1 protection current (mA) 

DelayOCD unsigned char 1 Discharge overcurrent 1 protection delay (S) 

OCD2vol signed long 4 Discharge overcurrent 2 protection current (mA) 

DelayOCD2 unsigned char 1 Discharge overcurrent 2 protection delay (125mS) 

DelayLoadR unsigned char 1 Load release delay (125mS) 

DSG1PWMFreq unsigned int 2 Discharge PWM frequency 

DSG1PWMRatioL unsigned char 1 Low-speed discharge duty cycle 

DSG1PWMRatioH unsigned char 1 High-speed discharge duty cycle 

TempOTD unsigned int 2 Discharge high temperature protection threshold (℃) 

TempOTDR unsigned int 2 Discharge high temperature protection recovery threshold (℃) 

TempUTD unsigned int 2 Discharge low temperature protection threshold (℃) 

TempUTDR unsigned int 2 Discharge low temperature protection recovery threshold (℃) 
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➢ Calibration settings 
 

 
 
 
 

 

 

Settings Description: 

Name Type of data Length Byte Function description 

VPackGain unsigned int 2 Total voltage gain 

CadcGain signed int 2 Current gain 

CadcOffset signed int 2 Zero current offset 

TS1Offset signed int 2 External temperature 1 offset 

TS2Offset signed int 2 External temperature 2 offset 
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2.5. Calibration interface 

The calibration function mainly provides board-level calibration, which can calibrate total voltage, external temperature, zero current, working current, 

and RTC time. After calibration, the calibration parameters will be written to MCU Flash storage area, used for subsequent calculations. 
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➢ Total voltage calibration 

The box on the left side of the calibration interface will display the total voltage value calculated by the current MCU. The user can manually input the 

calibration value in the corresponding box on the right according to the actual measured value. 

After finishing, click "Calibrate" to perform voltage calibration. After the calibration is completed, there will be a "calibration successful" prompt. 

Note: No load can be added during total voltage calibration. 

 

➢ Temperature calibration 

It can be calibrated separately for 2 groups of external temperatures. The box on the left side of the calibration interface will display the temperature 

value calculated by the current MCU. The user can correspond to the right side 

Manually enter the calibration value in the box. When all the entries are completed, click "Calibrate" to perform external temperature calibration, or you 

can calibrate each group of external temperature separately (check the right the corresponding small box), after the calibration is completed, there will be 

a "calibration successful" prompt. 

Note: No load can be applied during temperature calibration. 

 

➢ Current calibration 

It can be calibrated for board-level zero current and discharge current (simultaneous calibration is not allowed). 

You need to calibrate the zero current first and select the corresponding small box on the right (the system cannot b And the P+/P- terminal cannot be 

connected to any load equipment, even if the load equipment is not discharged), then calibrate the discharge current, and select the corresponding 

small box on the right (current during discharge). The display is a negative value, and the user can calibrate the discharge current according to the 

current during normal operation (the discharge current is at least 1A). 

The box on the left side of the calibration interface will display the current calculated by the MCU. The user can manually enter the calibration value in the 

corresponding box on the right according to the actual measurement. When the input is completed, click "Calibrate" to perform the corresponding 

current calibration. After the calibration is completed, there will be a "calibration successful" prompt. 

 

➢ RTC calibration 

When the system has an external EEProm&RTC module, you can calibrate the RTC time. Clicking on the calibration will update the current PC system time 

to the RTC module. 

Block to achieve RTC calibration. After calibration is completed, there will be a "calibration successful" prompt. 
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2.6. Backup interface 

When the system has an external EEProm&RTC module, the data backup function can be enabled, and the system will back up the 

system state information that the user needs to store to the external 

EEPRom, the user can read, erase, and save the system status information stored in the external EEPRom on this interface. 
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2.7. AFEReg interface 

When the IC model is SH367309/39F005, this interface will be displayed. Through this interface, you can read and write AFE 

registers for system configuration, voltage protection, current 

The functions and thresholds corresponding to protection and temperature protection are configured online, and after the conf iguration is 

completed, click Write Register. 

 

 

 


